
ProMark™500

Getting Started Guide

 
 
 
 



E
n
g
lish

Copyright Notice

Copyright 2008 Magellan Navigation. All rights reserved.

Trademarks

All product and brand names mentioned in this publica-
tion are trademarks of their respective holders.

FCC Notice

ProMark 500 Receiver complies with the limits for a 
Class B digital device, pursuant to the Part 15 of the 
FCC rules when it is used in Portable Mode. See Note be-
low related to Class B device.

Class B digital devices NOTE: This equipment has been 
tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protec-
tion against harmful interference in a residential instal-
lation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful in-
terference to radio communications. However, there is 
no guarantee that interference will not occur in a partic-
ular installation. If this equipment does cause harmful 
interference to radio or television reception, which can 
be determined by turning the equipment off and on, the 
user is encouraged to try and correct the interference by 
one or more of the following measures:

– Reorient or locate the receiving antenna.

– Increase the separation between the equipment 
and receiver.

– Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connect-
ed.

– Consult the dealer or an experienced radio/TV tech-
nician for help.

When ProMark 500 is used with an external power sup-
ply or connected to an external device using the USB 
port, it complies with the limits for a Class A digital de-
vice, pursuant to the Part 15 of the FCC rules. See Note 
below related to Class A device.

Class A digital devices NOTE: This equipment has been 
tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the in-
struction manual, may cause harmful interference to ra-
dio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in 
which case the user will be required to correct the inter-
ference at his own expense.

Remark: Any changes or modifications not expressly ap-
proved by Magellan Navigation, could void the right for 
user to operate the equipment.

RF Safety Exposure To Radio Frequency Energy (SAR)

Radio transmitting devices radiate Radio Frequency (RF) 
energy during its operation. RF energy can be absorbed 
into the human body and potentially can cause adverse 
health effects if excessive levels are absorbed. The unit 
of measurement for human exposure to RF energy is 
"Specific Absorption Rate" (SAR).

The Federal Communications Commission (FCC), Indus-
trie Canada (IC), and other agencies around the world 
have established limits that incorporate a substantial 
safety margin designed to assure the safety of all persons 
using this equipment. In order to certify this unit for sale 
in the US, Canada and Europe this unit has been tested 
for RF exposure compliance at a qualified test laboratory 
and found to comply with the regulations regarding ex-
posure to RF Energy. SAR was measured with the unit 
(GSM Module) transmitting at its maximum certified RF 

power. Often, however, during normal operation the unit 
(GSM Module) will transmit much less than maximum 
power. Transmit power is controlled automatically and, 
in general is reduced as you get closer to a cellular base 
station. This reduction in transmit power will result in a 
lower RF energy exposure and resulting SAR value.

SAR

ANSI/IEEE C95.1 1992FCC OET Bulletin 65 Supple-
ment C1999/519/CE.

The highest SAR value for this wireless survey system 
when worn on the body, as described in this user guide, 
is 1.44 W/kg. No separation from the body is required 
when the wireless survey system is in operation as the 
SAR measurements were taken with the unit "touching" 
the surface of the body. The device main intent use is for 
handheld operations only.

FCC and CE UHF Safety Statement

The different versions of the UHF Transmitters are FCC 
and CE compliant.

In order to comply with FCC and CE RF exposure safety 
guidelines as body-worn, normal use of unit, the follow-
ing must be followed:

A distance of AT LEAST 10 feet (3 m) of separation be-
tween the users body and the unit (UHF Transmitter). 
This distance has been defined taken into account the 
FCC and CE Requirements and the worst output power 
configuration.

Do NOT use the device in a manner such that it is in di-
rect contact with the body (e.g. on the lap). Such use will 
likely exceed FCC RF safety exposure limits. See 
www.fcc.gov/oet/rfsafety/ for more information on RF ex-
posure safety.

Replacing the Magellan U-Link Transmitter Power Fuse

The Magellan U-Link transmitter is protected by a 4-A 
fuse inserted in the data/power cable. This Y-shaped ca-
ble is used to connect the U-Link transmitter to the Pro-
Mark 500 receiver via a 7-pin connector, and to the 
power battery.

Should you have to replace this fuse, please get a spare 
fuse, 4 A, fast acting, ATO type, and then do the follow-
ing:

– Unplug the battery end of the data/power cable

– Open the fuse holder located along the data/power 
cable

– Extract the damaged fuse

– Insert the new fuse and then push the holder lid 
back into place

– Connect the data/power cable back to the battery.

Where to Find Information

This manual is designed to guide you through the basic 
ProMark 500 procedures. You can find additional infor-
mation in the ProMark 500 Reference Manual, also pro-
vided on the ProMark 500 CD.

Warranties

Refer to the ProMark 500 Reference Manual.
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Introduction

What is ProMark 
500?

Congratulations! You have just acquired the latest dual-
frequency ProMark 500 GNSS Surveying System from 
Magellan!
GNSS has revolutionized control surveys, topographic data 
collection and construction surveying. Purchasing the right 
tools for a professional job is essential in today's competitive 
business environment. Learning to put these tools to work 
quickly and efficiently will be the focus of the present 
manual.
Compared to its predecessors, ProMark 500 is more compact 
and lightweight while integrating more technology, such as 
the exclusive Magellan BLADE™ algorithms and multi-
constellation (GPS+GLONASS+SBAS) capabilities.
In addition, because it’s easy to use, you will be able to focus 
on your job and forget almost everything about the technical 
aspects of your equipment. No more cables, no more clip-on 
modules: ProMark 500 will be the reliable tool you are 
expecting for all your GNSS survey operations!

Scope of this 
Guide

This guide is designed to help you rapidly familiarize yourself 
with your new equipment. For the sake of conciseness, only a 
selection of the many ProMark 500 and FAST Survey 
functions are presented in this guide.
Most notably, in the RTK surveying section, only the use of 
radios is fully described in the implementation of the data 
link. The other solutions are only outlined. For a full 
description of these solutions, refer to the ProMark 500 
Reference Manual.
Likewise, in the Logging Raw Data section, the assumption is 
made that raw data logging takes place simultaneously with 
the RTK field operations, which means the setup and 
configuration of the equipment is as described in the RTK 
surveying section. In fact, post-processed surveys can be 
conducted with ProMark 500 using optimized setups and 
configurations for static, Stop&Go and kinematic surveys. 
These are also discussed in the ProMark 500 Reference 
Manual.
Lastly, this guide only introduces a couple of FAST Survey 
functions, which are “Stake Points” and “Store Points”. For 
a detailed and comprehensive description of all the FAST 
Survey functions, refer to the FAST Survey Reference Manual.
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System Components Overview

The tables below provide an overview of the different key 
items composing the ProMark 500. 
Depending on your purchase and based on the type of survey 
you wish to perform, you may only have some of the listed 
items. Please refer to the packing list for an accurate 
description of the equipment that has been delivered to you.

Basic Supply

Accessories, 
General Purpose

Item Part Number Picture

ProMark 500 GNSS Receiver 990596

7.4 V-4.4 Ah Li-ion Battery Pack 
(rechargeable) 111374

ProMark500 User Documentation 
CD 501503

Item Part Number Picture
AC/DC Power Supply Kit (includes 
external AC adapter, battery charger 
and cable extension for powering 
ProMark 500 directly from the AC 
adapter)

802064

USB Device Cable (short).
Makes ProMark 500 a USB host. 702103

USB Host Cable (long)
Makes ProMark 500 a USB device. 702104

HI Measurement Tool 111146
2
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Communication 
Modules and 

Associated 
Antennas

Vertical Antenna Extension 103717

Field bag 205923

Optional carrying case, rigid, for 
base/rover system 206215

Item Part Number Picture

Item Part Number Picture

Magellan U-Link 
Transmitter 110991

Quad-band GSM 
antenna 111397

PacCrest Trans-
mitter, high power TN2PDL35W

Radio receiver kit 
(includes radio 
module, whip 
antenna and 
small parts)

802068-10 (410-430 MHz, 12.5 kHz)
802068-15 (410-430 MHz, 25 kHz)
802068-30 (430-450 MHz, 12.5 kHz)
802068-35 (430-450 MHz, 25 kHz)
802068-50 (450-470 MHz, 12.5 kHz)
802068-55 (450-470 MHz, 25 kHz)
3
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Equipment Description & Basic Functions

Front Panel View

Indicators & 
Controls

Power button
To turn on the ProMark 500, hold the Power button pressed 
until the power LED lights up.
To turn off the ProMark 500, hold the Power button pressed 
until the “Magellan Professional” screen is displayed. Then 
release the button and wait until the ProMark 500 shuts 
down.

Power LED
This indicator is on when the ProMark 500 is on, and off 
when it is off.

Display Screen
The display consists of a 128 x 64-pixel, 1.5-inch 
monochrome yellow screen using organic LED technology 
(OLED). It is oriented slightly downwards so the screen can 
easily be read when the ProMark 500 is installed on top of a 
range pole. 
Used in conjunction with the Scroll button, the display screen 
allows you to view different pages of information. See Display 
Screens on page 9 for a detailed description of the 
information available from this screen.

Power Button

Log Button Scroll Button

Power LED

Display Screen
4
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After a few seconds of inactivity (i.e. Scroll button idle), the 
display will go out.

Scroll button
Press this button shortly to scroll through the different pages 
of information viewed on the screen.
If an alarm is reported on the display screen, a short press on 
the Scroll button will acknowledge the alarm. The Scroll 
button will recover its display scrolling function only after all 
the alarms have been acknowledged this way.
Another function of the Scroll button is to re-activate the 
screen backlight after the latter has automatically been 
turned off. The Scroll button is also used in the firmware 
update procedure.

Log Button
Press this button briefly to start recording raw data on the 
selected storage medium.
Another short press on this button will immediately stop raw 
data recording.

Buzzer
The internal buzzer will sound an alarm whenever a warning 
message is reported on the screen. The buzzer will beep until 
you acknowledge the warning message by pressing the Scroll 
button.

Bottom View

5/8”  adaptor Battery
Compartment

GSM Antenna
Radio Antenna

DC Power Input

RS232/422 port
(port A)

Radio module

Bluetooth (port C)

Front Panel

USB Port
5
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Battery, 
Connectors & 

Module

Battery Model & Battery Compartment

The battery used in the ProMark500 is a 7.4-V DC - 4400 
mAh rechargeable battery. It is a standard model used in 
many camcorders.
The battery is housed in a battery compartment accessible 
from underneath the ProMark 500. The compartment door 
can be removed using a coin to release the two quarter-turn 
screws.

DC Power Input
A three-contact, female connector (Fischer type) allowing the 
ProMark500 to be powered from the provided AC adapter. 
(Connect the cable extension between ProMark 500 and the 
end of the AC adapter output cable). 

GSM Antenna
A coaxial female connector (SMA type) allowing you to 
connect a GSM whip antenna to the ProMark 500.

Radio Antenna
A coaxial female connector (TNC type) allowing you to 
connect a radio whip antenna to the ProMark 500. This 
connector is available only if the ProMark 500 has been fitted 
with a radio module.

Radio Module
A module allowing ProMark 500 to receive and process 
corrections from a base. When a radio module is used, a radio 
antenna must be connected (see above). When no radio 
receiver kit is delivered, a single compartment door is 
provided instead, with no connector on it.
6
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USB Port
A nine-contact female connector (Fischer type). Depending 
on how it is configured, the USB port can be used in two 
different ways:
1. For a USB host such as a mass storage device. In this 

case, you should use a special adaptor cable to attach the 
USB key to the ProMark 500. This configuration can be 
used to log raw data on the USB key or upgrade the 
ProMark 500 firmware from the files stored on the key.

2. For a USB device allowing ProMark 500 to be seen as a 
disk from the computer connected to this port. In this 
configuration, files can be transferred between the 
ProMark500’s internal memory and the computer.

RS232/422 Serial Port
A seven-contact female connector (Fischer type) allowing you 
to connect the ProMark 500 to an external device via an 
RS232 or RS422 serial line (default: RS232). Changing the 
configuration of the port can be done from the field terminal 
using a $PASHS serial command, as explained in the 
ProMark 500 Reference Manual.

Bluetooth Device
An integrated Bluetooth module allowing the ProMark 500 to 
communicate with a Bluetooth-enabled field terminal 
through a wireless connection.
7
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Antenna 
Characteristics

The two figures below give the dimensional parameters of the 
ProMark 500 antenna required for the system to determine 
the true height of the antenna from the measured value 
obtained using one of the standard height measurement 
methods, i.e. slant or vertical.

The height mark allows you to hook the measure tape onto it 
so you can unroll the tape down to the survey mark and read 
the slant height measurement directly on the tape.

Special Button 
Combinations

• With the ProMark 500 OFF, pressing the Power, Log and 
Scroll buttons simultaneously for a few seconds will 
restore all the factory settings. Always use this 

combination after changing the radio module. This allows 
the receiver to recognize the new module.

• With the ProMark 500 OFF and a USB key connected, 
pressing the Power and Scroll buttons simultaneously for 
a few seconds will cause the ProMark 500 to start a 
firmware upload process. If there is no USB key 
connected or the key does not contain a firmware update, 
then the process will abort after a few seconds.

These button combinations are summarized in the table 
below:

91
.9

2 
m

m

95
.0

2 
m

m
L1
L2

Antenna Radius
= 98 mm

Height Mark

SHMP Offset

=40 mm

Button 
Combination

ProMark 500 
State Function

Power+Log+Scroll OFF Restores Factory Settings.

Power+Scroll OFF Initiates firmware update from USB key.
8
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Display Screens

If you press the Scroll button several times, you will see the 
following displays successively.

Power-On Screen When you power on the ProMark 500, the Magellan 
Professional logo appears on the screen. It is displayed until 
the ProMark 500 has completed its auto-test (this takes 
about 30 seconds).

Then the General Status screen is displayed. 

General Status 
Screen

An example of General Status screen is shown below.

This screen displays the following information:

• : Satellite icon [1] (always displayed).
• Number of satellites tracked [2].
• Position solution status [3]:

– AUTO: Autonomous GPS position
– FLOAT: Float solution
– FIXED: Fixed solution (RTK is operational)
– BASE: This ProMark 500 is configured as a base.

• Number of satellites used [4]: Number of satellites 
involved in the position processing, regardless of the 
current position solution status.

[1]

[9] [10] [11] [12] [13]

[2] [3] [4]

[5]

[6]

[8]

[7]
9
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• : Data link icon [5]. This icon is displayed only when 
corrections are received and at least a float solution is 
available.

• Age of corrections [6], in seconds. This value is displayed 
only when corrections are received.

• : Raw data logging icon [7]:
– Animated: Raw data logging in progress
– Fixed: No raw data logging in progress.

• Percentage of free memory in the storage medium used 
[8].

• : Battery icon [9] with visual indication of remaining 
charge. If an external power source is used (AC adapter or 
external battery), the battery icon will be animated to 
indicate battery charging in progress.

 is displayed when there is no battery in the 
compartment and the ProMark 500 is operated from an 
external power source. 

• Power status [10].

• Alarm status [11].

• GSM status [12]. This may be one of the following icons:

Icon Definition
Percent 
value

Percentage of remaining battery. This indication will flash 
when the remaining energy drops below 5%.
Replaces percentage when an external power source is 
used.

Icon Definition
Alarm detected. Press the Scroll button to view the alarm 
type. Press it again to acknowledge the alarm, which then 
disappears from the list. Unless there is another alarm in the 
queue, in which case you will have to resume the acknowl-
edge sequence, the screen then displays the memory 
screens.

None No alarm detected

Icon Definition

GSM module on line.

GSM module off line. The displayed icon indicates the current 
GSM signal strength from the current location. (Blank if no 
signal at all.)
10
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• [13]: USB status and/or Bluetooth status. 

Memory Screens From the General Status screen, press the Scroll button to 
access the Memory screens. Memory screens appear 
successively (see examples) at a display rate of about five 
seconds:

Left screen:
• First line: Percentage of free space in the internal 

memory.
• Second line: Number of files currently stored in the 

internal memory.
• Third line: Percentage of free space on the USB mass 

storage device.
• Fourth line: Number of files currently stored on the USB 

mass storage device.

Right screen:
• First line: Total space occupied by the files currently 

stored in the internal memory.
• Second line: Nominal size of the internal memory.
• Third line: Total space occupied by the files currently 

stored on the USB mass storage device.
• Fourth line: Nominal size of the USB mass storage 

device.

About the “*” symbol:
• It can only appear at the end of the first or third line.
• Where placed, it indicates that this storage medium is 

used for the data recording session in progress.

Icon Definition

USB port connected to active device

Bluetooth active

/
These two icons will appear successively when both the 
USB port and Bluetooth are active.

Blank USB port unconnected and Bluetooth inactive.
11
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What if there is no USB mass storage device connected to 
ProMark 500?
• Parameters relevant to the USB key size and space used 

and available are void (three dots displayed instead).
• Number of files is forced to “0”.

Receiver 
Identification 

Screen

From any of the two Memory screens, press the Scroll button 
to access the Receiver Identification screen. See example 
below.

• Receiver Serial Number
• Firmware Version
• Receiver Bluetooth Identifier

A new press on the Scroll button will take you back to the 
General Status screen. From any screen, a long press on the 
Scroll button will also take you back to the General Status 
screen.

Screen Backlight The screen backlight is automatically turned off if no key is 
pressed for 1 minute. When the backlight is off, a short press 
on the Scroll button will turn it back on. The Scroll button will 
then recover its usual functions.

Data Transfer 
Screen

For more information on the screen displayed when 
downloading files, refer to Downloading Raw Data on page 34.
12
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Charging Batteries Before Use

Make sure the battery is fully charged for each ProMark 500 
you will be using in the field. Follow the instructions below to 
charge a battery.

Removing the 
Battery from the 

ProMark 500

Unless the battery has already been taken out, do the 
following:
• Put the ProMark 500 upside down.
• Remove the battery door, accessible from underneath the 

ProMark 500, by loosening the two quarter-turn screws 
(see picture) using a coin.

• Keeping one hand on the battery still in its compartment, 
put the ProMark 500 the right way up. The battery will 
then easily slide out of the battery compartment. 

Charging the 
Battery

The battery charger comes with a separate universal AC 
adapter fitted with a 1.5-m output cable. The AC adapter 
includes a choice of four different, detachable plug types. 
Follow the instructions below to operate the charger.
• Choose the plug type that is suitable for your country.
• Secure that plug on the AC adapter by giving the plug the 

right orientation with respect to the adapter, then pushing 
and rotating it by about 10 degrees clockwise until you 
hear a “click”.

• Connect the cable from the AC adapter to the battery 
charger.

• Give the battery the right orientation with respect to the 
charger [1] (the battery terminals should come into 
contact with the two sets of connectors on the charger), 
13
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then push the battery against the plate and slide it forward 
[2] until it locks into place. 

• Plug the adapter into an AC outlet. Battery charging starts 
immediately.
For a low battery that’s being charged, you will first see the 
three LEDs switch on and off, one after the other, followed 
by a short period of time when none of the LEDs is on (see 
[3]).
After about two hours of charging, the MED LED will stay 
on [4]. A few minutes later, the HI LED [5], and then the 
MAX LED [6] will also stay on.

• When the three LEDs are on, this means the battery is 
fully charged and can be disconnected from the charger.

Inserting the 
Battery in the 
ProMark 500

• With the ProMark 500 upside down, insert the battery into 
the compartment making sure the battery has the right 
orientation (the battery terminals should come into 
contact with the two sets of connectors located at the 
bottom of the compartment). 

• Place the battery door over the battery and tighten the two 
screws, using a coin. Note that, once it is properly 
secured, the battery door pushes the battery against the 
bottom of the compartment to ensure electrical 
connection of the battery to the ProMark 500.

[1] [2]

11
2

MED MAXHI

MED MAXHI

[3]

[6]

MED MAXHI
[5]

MED MAXHI
[4]
14
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RTK Base Setup

Prerequisites • You will need a tripod and a tribrach (not provided) to 
install the base. The provided antenna extension pole 
fitted with a 5/8” male adaptor is also required in this 
configuration.

• For a long-range radio link, i.e. more than 1 mile or 1.6 
km, for which the radio antenna should be placed as high 
as possible, Magellan recommends you install the antenna 
on top of an antenna pole secured on a tripod (neither of 
these items is provided).

• To operate the base with a radio, you need an external 9- 
to 28-V DC power source such as a standard 12-V DC 
battery (not provided), which means the ProMark 500 
internal battery will not be needed in this case. 
15
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Magellan Radio 
Link

The connection diagram is as follows.

Mount the different items as shown on the picture.

External 12 -V Battery

U-Link TransmitterProMark 500 Base

Cable P/N 730476

Cable P/N 730477

Power RS (Port A)

+ -
16
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PacCrest Radio 
Link

The connection diagram is as follows.

Mount the different items as shown on the picture.

External Battery

PDL 35-W
Transmitter

ProMark 500 Base

Data/Power Cable

Radio Antenna

Cable P/N 730477

Power RS (Port A)

+ -
17
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RTK Rover Setup

Prerequisites
• Use a range pole fitted with a 5/8” male adaptor at the 

upper end (not provided).
• If a radio link is used with the base, your rover should 

normally have been fitted with the radio module that 
matches the reception band covered by the radio 
transmitter used at the base.

• If a GPRS connection is used, your rover should normally 
have been fitted with the SIM card that will allow it to 
perform a network connection.
To connect the SIM card, first use a flat screwdriver  to 
loosen the two quarter-turn screws securing the radio 
module. Remove the module. This gives access to an 
electronic card on which you can insert the SIM card as 
shown on the picture.

Radio Link
Mount the different items as shown on the picture, including 
the ProMark 500 [1], the radio antenna [2], the range pole 
[3] and the field terminal with its mounting bracket [4].

GSM/GPRS 
Connection

As a standard feature, the ProMark 500 incorporates a built-
in GSM module, which means you only have to connect the 
GSM antenna if you have paid for activation of the hardware. 
Mount the different items as shown on the picture, including 
the ProMark 500 [1], the GSM antenna [2], the range pole 
[3] and the field terminal with its mounting bracket [4]. 

[1]

[2]

[3]

[4]

[1]
[2]

[3]

[4]
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Getting Started With FAST Survey

Registering as a 
FAST Survey User

The first time you start FAST Survey, you will be prompted to 
register your license of the software. If you do not register, 
FAST Survey will remain in demo mode, limiting each job file 
to a maximum of 30 points.

How to Register
FAST Survey registration is done via the Internet at the 
following address: Magellan FAST Survey Registration 
Choose Yes to start the registration process. You will be 
required to enter:
• Your company name
• Your phone number
• Your email address
• Your FAST Survey serial number
• The registration code that the program will generate.

After you submit this information, your change key will be 
displayed and emailed to the address that you submit. Keep 
this for your permanent records.
If you do not have access to the Internet, you may fax the 
above information to (+1) 606-564-9525. Your registration 
information will be faxed back to you within 48 hours. During 
this time, you may continue to use the program without 
restriction. After you receive your Change Key, enter it and tap 
OK. You can then create a new FAST Survey job, as explained 
further.

Saving your registration in the Field Terminal 
After you register FAST Survey, you may need to perform a 
RAM backup or a System Save to be sure your authorization 
code will not be lost the next time the field terminal reboots.
If you cannot find this option on your Start menu, then open 
the Control Panel and choose RAM backup.
With a Magellan MobileMapper CX, the code is automatically 
and safely saved at the end of the registration procedure (no 
extra save operation is required).
19

http://update.carlsonsw.com/decode_xml.php?reg_type=dc&prod_name=Magellan%20Fast%20Survey


E
n
g
lish
Creating a New FAST Survey Job

1. Turn on the field terminal and wait until the boot 
sequence is complete.

2. Double-tap  to launch FAST Survey.
3. Tap the Select New/Existing Job button. This opens the 

Coordinate Files window.
4. Tap on the highlighted “crd” file name located at the 

bottom of the screen. This opens FAST Survey’s virtual 
keyboard with the file name now appearing above.

5. Using the keyboard, type in the name of the “crd” file in 
which FAST Survey will store the data you will collect 
during your job.

6. Tap . This takes you back to the Coordinate Files 
window where your file name now appears in the Name 
field.

7. Tap  again. This opens the Job Settings window, which 
consists of five different tabs on which you can set a large 
number of parameters pertaining to the job (or future 
jobs).
Only the parameters that make sense with a GNSS system 
such as the ProMark 500 are presented below. All other 
parameters should be kept with their default settings. 
On the System tab:
– Distance: Choose the unit in which all measured 

distances will be expressed (US Survey Feet, Metric or 
International Feet). Unless “Metric” is selected, you 
can also choose the units in which distances will be 
displayed (“Decimal feet” or “Feet and Inches”). 
Warning! You cannot change this setting after creating 

the file!

– Angle: Choose the unit in which all measured angles 
will be expressed (degrees, minutes, seconds or 
grades)

– Zero Azimuth Setting: Choose the direction for which 
azimuth is arbitrarily set to 0° (North or South)

– Projection: Choose a projection from the combo box. To 
select a different projection, tap the Edit Projection List 
button. The Add Predefined button allows you to select 
an existing projection. The Add User Defined button 
allows you to create an entirely new projection. The 
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selected or created projection will then be selectable 
from the combo box.

On the Stake tab:
– Precision: Choose the number of decimal places (0 to 

5) used to express the three coordinates of any 
stakeout point. “0.000” (3 decimal places) is the best 
setting to fully benefit from the precision offered by 
ProMark 500.

On the Format tab:
– Coordinate Display Order: Choose the order in which you 

want FAST Survey to display East and North 
coordinates (East,North or North,East).

– Angle Entry and Display: Choose the type of angle FAST 
Survey will display (Azimuth or Bearing).

8. Tap . This creates the file, closes the Job Settings 
window and takes you to the FAST Survey menu. If no 
Bluetooth connections were configured beforehand, then 
the Bluetooth Devices window will open to let you do so.

How FAST Survey 
Interfaces with 

ProMark 500 Via 
Bluetooth

First-Time Use
Right after you start FAST Survey and create or open your first 
job, FAST Survey will try to re-activate the Bluetooth 
connections established during the previous session. 
Because it’s your first session, the Bluetooth Devices window 
will open instead, prompting you first to define a Bluetooth 
connection with the base.
• Assuming your base and rover are nearby and powered on, 

tap Find Receiver. Wait until FAST Survey lists the 
Bluetooth identifiers of your base and rover. The list 
appears in a new window.

• Highlight the Bluetooth identifier corresponding to the 
base. To make sure you select the right identifier, press 
the Scroll button on the base until you display the 
Receiver Identification screen. The identifier is in the 
lower line (after the “BT:” prefix).

• Tap . This takes you back to the previous screen where 
the selected Bluetooth identifier remains highlighted in 
the list. The following actions may be performed on the 
selected receiver using the following buttons:
• Set Receiver Name: By default, the “Receiver Bluetooth 

Identifier” of the detected receiver is assigned to this 
parameter. You may use a more self-explanatory name 
to identify your base (e.g.: “MyBase”). 
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• Set Receiver PIN: Do not use this button. In its default 
configuration, ProMark 500 does not request a PIN 
code to allow a third equipment to connect to it via 
Bluetooth.

• Delete Receiver: Removes the selected receiver from the 
list of remote receivers detected by Bluetooth. 

• Tap  to connect the field terminal to the base via 
Bluetooth and then configure the base according to your 
needs (see RTK Base Configuration on page 23).

• Later, you will establish a Bluetooth connection with the 
rover. The process will start when you tap Equip>GPS Rover 
to configure the rover. From the Comms tab, you will be 
able to access the Bluetooth Devices window and select 
the rover receiver from the list of remote receivers 
detected by Bluetooth, in the same way as you did for the 
base.

Switching Between Base and Rover
During a FAST Survey session, you can quickly change the 
receiver you are communicating with (provided the receiver 
you want to communicate with is within Bluetooth range). 

The  icon located in the upper-right corner of the FAST 
Survey window allows you to change receivers. Tap on this 
icon and then:
• Select GPS Base to switch to the base,
• Or select GPS Rover to switch to the rover.

NOTE: If you examine more carefully this icon, you will see 
that it changes aspect (base or rover icon) depending on 
which receiver is currently communicating with FAST Survey.
In addition, on the Equip menu, a small check box appears in 
the icon inside either the GPS Rover or GPS Base button to 
indicate which connection is active.

Subsequent Uses
In the next sessions of FAST Survey, Bluetooth connections 
will be transparent to you. After you have opened a job, FAST 
Survey will always re-activate the Bluetooth connections with 
the receivers it can detect in the vicinity. This will allow you 
to directly start your job without having to worry about 
Bluetooth connections.
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RTK Base Configuration

Prerequisites • Your base is properly set up and powered on. It is on its 
definitive location for the survey and the field terminal is 
located at less than 10 metres from the base. 

• Your field terminal is on, FAST Survey is running, a 
Bluetooth connection has already been configured (with 
the base; see How FAST Survey Interfaces with ProMark 
500 Via Bluetooth on page 21) and a job file is open.

• In FAST Survey, tap on the Equip tab and then the GPS 
Base button. A message may appear asking you to confirm 
your choice of configuring a base. Tap Yes. This opens the 
Current tab of the GPS Base window.

Set Manufacturer 
& Model 

• Set the Manufacturer (“Magellan Navigation”) and Model 
(“ProMark 500”) of the equipment used as the base.

Check/Change 
Bluetooth 

Connection

• Tap on the Comms tab. Since the Bluetooth connection 
was performed earlier, just check that FAST Survey is 
properly configured to communicate with the base. You 
should read:
• Type = “Bluetooth”
• Device = “Magellan BT”
• Instr = should be set to the name you gave earlier to the 

base, as seen from FAST Survey Bluetooth.

Note that the Configure button next to the Device field 
allows you to return to the Bluetooth Devices window 
through which you earlier configured the Bluetooth 
connection to the base (see How FAST Survey Interfaces 
with ProMark 500 Via Bluetooth on page 21). Changes 
can be made now if necessary.

Set Receiver 
Parameters

• Using the HI measurement tool provided, perform a slant 
measurement of the antenna height (recommended).

• On the field terminal, tap on the Receiver tab.
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• Select the Slant option for the antenna height 
measurement.

• Tap within the Antenna Height field and enter the value you 
have just measured.

• Choose your preferred settings for Elevation Mask, Use SBAS 
Satellites and Use GLONASS Satellites.Using SBAS and/or 
GLONASS satellites will help the rover maintain the 
availability of fixed positions in those difficult 
environments where GPS alone would fail to do so.

Set Radio Link & 
Transmitter

• Tap on the RTK tab and set the radio link according to the 
table below.

• Tap on the Config button to set the radio transmitter:

• Tap  to load the settings to the radio. This may take a 
few seconds. FAST Survey then returns to the GPS Base 
configuration window.

Load Configuration 
to the Base

Now that you have browsed all the tabs in the Base 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the base. This may 
take a few seconds.

Set Base Position FAST Survey then asks you to set the base position. 
Depending on the chosen method, follow the instructions 
displayed on the screen to define this position. This 
completes the base configuration phase.
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Field Magellan Pacific Crest
Device Magellan Radio Pacific Crest
Baud (forced to 19200 Bd) “38400 Bd” recommended.

Message 
Type

Available formats are: 
RTCM V3.0, RTCM V2.3, 
CMR+ and CMR.

Available formats are: RTCM 
V3.0, RTCM V2.3, CMR+ and 
CMR.

Base ID
Choose any number at 
your convenience between 
0 and 4095.

Choose any number at your 
convenience between 0 and 
4095.

Field Magellan Pacific Crest
Protocol - “Transparent” recommended

Channel Choose channel used 
(channel No. - Frequency)

Choose channel used (chan-
nel No. - Frequency)

Over the 
Air Baud - “9600 Bd” recommended
24
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RTK Rover Configuration

Prerequisites • Your rover is properly set up and powered on. 
• Your field terminal is on, FAST Survey is running and a job 

file is open.
• In FAST Survey, tap on the Equip tab and then the GPS 

Rover button. A message may appear asking you to 
confirm your choice of configuring a rover. Tap Yes. This 
opens the Current tab of the GPS Rover window.

Set Manufacturer 
& Model 

• Set the Manufacturer (“Magellan Navigation”) and Model 
(“ProMark 500”) of the equipment used as the rover.

Set Bluetooth 
Connection

• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Magellan BT”.
• Tap on the Configure button to access the Bluetooth 

Devices window.
• Select the rover from the list of detected receivers. To 

make sure you select the right identifier, press the Scroll 
button on the rover until you display the Receiver 
Identification screen. The identifier is in the lower line 
(after the “BT:” prefix).
You may give the rover a more familiar name (e.g. 
“MyRover”) using the Set Receiver Name button. 

• Tap  to connect the field terminal to the rover via 
Bluetooth. FAST Survey then returns to the GPS Rover 
configuration window.

• Check that the rover name is now selected in the Instr 
field.
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Set Receiver 
Parameters

• Measure or read the length of the range pole on top of 
which the ProMark 500 is mounted.

• On the field terminal, tap on the Receiver tab.
• Select the Vertical option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured or read for the range pole length.
• Choose your preferred settings for Elevation Mask, 

Ambiguity Fixing (see also table below), Use SBAS Satellites 
and Use GLONASS Satellites.Using SBAS and/or GLONASS 
satellites helps to maintain the availability of fixed 
positions in those difficult environments where GPS alone 
would fail to do so.  You should only select SBAS and/or 
GLONASS when you know you are receiving corrections for 
these satellite systems from either your own base or from 
a network.

Set RTK Mode • Tap on the RTK tab and set the radio link according to the 
table below.
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Choice Definition

Float Choose this option if you only need decimeter accuracy 
(position status will never go to “Fixed”).

95.0 95% confidence level
99.0 99% confidence level (default and recommended setting)
99.9 99.9 confidence level

Field Radio GSM/GPRS/Network
Device Pacific Crest Internal GSM

Network -

Choose the RTK mode that suits 
your application (TCP/IP Direct, 
UDP/IP Direct, NTRIP, SpiderNet  or 
Direct Dial)

Send 
Rover 
Position to 
Network

Disable this 
option.

Enable this option if TCP/IPDirect IP 
or NTRIP is used 
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• If you choose “Pacific Crest”, tap on the Config button 
next to the Device field to set the radio receiver:

Then tap  to load the settings to the radio. This may 
take a few seconds. FAST Survey then returns to the GPS 
Rover configuration window.

• If you choose “Internal GSM”, tap on the Config button 
next to the Device field to set the internal modem. Then 
tap on the Config button next to the Network field to set the 
GSM/GPRS connection. The table lists all the parameters 
that need to be defined.

Load Configuration 
to the Rover

Now that you have browsed all the tabs in the Rover 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the rover.

Field Setting
Protocol “Magellan” recommended
Power Management “Automatic” recommended

Channel Choose channel used (Channel No. - Fre-
quency)

Squelch “High” recommended
Over the Air Baud “9600 Bd” recommended

Parameter TCP/IP
UDP/IP NTRIP SpiderNet Direct 

Dial
Name • • • •
Address • •
IP Address •
Port • • •
User Name • •
Password • •
Broadcaster Info •
Phone Number •
27
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RTK Surveying

Uploading 
Stakeout Points to 
the Field Terminal

In your office, do the following:
• Connect the field terminal to your office computer using 

the USB data cable.
• Make sure ActiveSync is installed on your computer and is 

allowed to perform USB connections. If you do not have 
ActiveSync installed, download the latest version from the 
following web page:
hhttp://www.microsoft.com/windowsmobile/activesync/
default.mspx

• Run FAST Survey on the field terminal.
• Run GNSS Solutions on your office computer.
• Open the project containing the stakeout points you want 

to transfer to the field terminal as your job.
• On the project map view, select all the reference and 

target points making up your job.
• Select Project>Upload Positions to External Device..
• Select RTK Job and FAST Survey data collector.
• Click OK.
• Name the job (e.g. MYJOB). Keep the Selected Targets and 

References option selected and click OK. This opens the 
Data Transfer dialog box.

• In the combo box, select Active Sync and keep Automatic 
transfer enabled.

• Click OK to establish the connection with the field 
terminal and upload the job (to \MyDevice\FAST 
Survey\Data\).

• After the job has been uploaded, turn off the field 
terminal, disconnect the USB cable and go to the field 
with your surveying equipment to stake out your points.

Staking Out Points

1. Run FAST Survey and open the job containing the points 
you want to stake out.

2. Tap on the Survey tab and then select Stake Points. The 
screen now displayed allows you to stake out points.

3. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its 
coordinates in the Northing, Easting and Elevation fields, or 
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select a pre-defined point from the points list (see File>List 
Points). You can also define graphically the point by 
tapping on the point on the graphic screen, or define the 
point according to azimuth, slope and horizontal distance.

4. Once you have chosen a point, tap . A graphic screen 
is now displayed to help you head for the point.

Name of 
stakeout point

Coordinates of 
stakeout point

Provides access to point list.
Example of points list:

Provides access to graphic screen

Next stakeout point

Logs stakeout point

Current status of 
position solution

Name, coordinates of 
stakeout point, quality data, 
deviation data
(Use the up/down arrow 
keys to show/hide this 
information)

Takes you back to the 
point selection screen

Configures general 
case of point logging

Provides access to 
monitor screen

Provides access to 
screen below (Select 
“Text” in menu)

Your current position 
and heading

Stakeout point (target)

GNSS antenna height

Viewing parameters

Zoom settings
29
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Yellow helmet gives 
access to Function 

Menu!

5. When the distance to the stakeout point is too small to be 
clearly seen on this screen, tap on the surveyor’s helmet 
in the upper-left corner and select Text from the menu that 
pops up.
A new screen appears giving a more accurate view of the 
remaining distance to the stakeout point. (If you want to 
return to the previous screen, just select Graph in the same 
menu.)

When the remaining distance is within the stakeout 
tolerance (this parameter can be changed in 
Equip>Tolerances), markers appear in the four corners of 
the target. You can now set a stake on this point.

6. Tap on the STORE button if you want to store the position 
of this point. You will be notified if the values of HRMS 
and VRMS exceed the tolerances set for these two 
parameters in Equip>Tolerances. A new screen is then 
displayed showing the coordinates of both the staked and 
design points. 

Stakeout point (target)

Provides access to 
previous screen
(Select “Graph” in menu)

Your current position 
and heading

Used to select which 
guidance data to display 
(underneath)

Used to select which 
guidance data to display 
for the point: coordinates 
or quality data

Current status of 
position solution
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7. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then comes back to the Stake Points 
screen where you can choose the next point to be staked.

8. After staking out all your points, tap  in the upper-
right corner of the screen to return to the menu.

Logging Points 1. Tap on the Survey tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

2. Type in the point name and description in the 
corresponding two fields (see above)

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters
Zoom settings

Logging points with 
position averaging

Logging point 
with offset

Logging point 
(general case)

Enter point name 
and description in 
these two fields

Current position and 
related quality figures
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3. Tap on the “A” button
4. Enter the number of readings you want before FAST 

Survey is allowed to compute an average position for this 
point.

For example, type in “5” and tap .
Messages follow successively indicating that the system is 
taking the five requested readings. Then FAST Survey 
displays the average coordinates it has determined for the 
point.

5. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.

6. After logging all your points, tap  in the upper-right 
corner of the screen to return to the menu.

Downloading RTK 
Points to GNSS 

Solutions

• Go back to your office and connect the field terminal to 
your office computer using the USB data cable.

• Run GNSS Solutions on your office computer.
• Open the project in which to add the points from the field.
• Select Project>Download Positions from External Device..
• Select RTK Results and FAST Survey data collector.
• Click OK. This opens the Data Transfer dialog box.
• In the combo box, select ActiveSync, enable Automatic 

Transfer and click OK. This opens a new window listing all 
the jobs stored in the field terminal.

• Select the job you want to download (e.g. “MYJOB”) and 
click OK. This starts the download process.
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Logging Raw Data

Introduction ProMark 500 allows you to log raw data in two different ways:
• Standalone: You simply need to use the Log button to start 

and stop raw data logging.
Later, during the post-processing, you will need to 
manually correct all computed elevations for the antenna 
height.

• Using FAST Survey: The Survey>Log Raw GPS function 
allows you to fully control raw data logging. Using this 
method offers three advantages:.
1. Antenna reduction is automatically performed during 

post-processing because of the antenna height value 
(from the receiver properties) stored in the raw data 
files.

2. Ability to insert time tags into the raw data file.
3. Ability to pause/resume data logging.

By default, raw data is logged to the ProMark 500’s internal 
memory.
Using FAST Survey, you can change the storage medium 
(internal memory or USB memory stick).
The choice of storage medium is then valid for both data 
logging methods (standalone and using FAST Survey). If 
“USB memory stick” is selected and no USB stick is 
connected to the ProMark 500, then no data logging will take 
place.
In both data logging methods, the Raw Data Logging icon on 
the General Status screen will start flashing when a raw data 
file is open for logging.

Raw Data Logging 
Methods

Standalone
• Press the Log button to start data logging.
• Press the Log button again when it’s time to stop data 

logging.

Using FAST Survey
• Tap Survey>Log Raw GPS.
• Tap Start File.
33



E
n
g
lish
• Set the following parameters:
– Elevation Mask in degrees.
– Check the antenna height value. If it’s wrong, tap the 

Change Ant. button to set the new value.
– Storage medium (internal or USB memory stick). 

Choosing the internal memory is recommended. The 
use of a memory stick should be restricted to 
downloading raw data files.

– Logging interval in seconds.

• Tap . This starts data logging. From the screen then 
displayed, you can do the following:
– Mark a particular point or event in the file (Tag New 

Site)(cf. Stop & Go surveying). 
– Stop data logging (Close File).
– Access the File Manager window in read-only mode 

(File Manager).
– Continue Logging / Pause Logging. Pausing data logging 

means closing the currently open file. Continuing data 
logging means opening a new file. Data logging will 
start immediately based on the parameters set for the 
previous file. 

Combining the two Methods
Combining the two methods is possible.
For example, you can start data logging using FAST Survey. 
Then you can quit FAST Survey and turn off the field terminal 
without disturbing data logging. Later, you will be allowed to 
stop data logging by simply pressing the Log button on the 
ProMark 500 front panel.

Downloading Raw 
Data

Use a USB mass storage device as a transit storage medium 
to download raw data from the ProMark 500’s internal 
memory to your office computer.
After downloading the files to this device, connect the USB 
device to your computer and use your usual browser to copy 
the files to the project folder.
• Connect the USB mass storage device to the ProMark 500 

via the short USB Device cable provided (P/N 702103).
If raw data files are present in the ProMark 500’s internal 
memory, the following icons will automatically appear on 
the display screen:
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• To confirm the file transfer, press the Log button. The 
General status screen will re-appear once the file transfer 
is complete.

• To cancel the file transfer, press the Scroll button.
• If you do not press any button within the next 10 seconds, 

the download procedure will be canceled automatically 
and the screen will come back to the previous display.

Deleting Raw Data Files

Use FAST Survey to delete raw data files from the ProMark 
500 internal memory. Make sure no raw data logging is in 
progress otherwise you won’t be able to delete any file.
1. Tap on the Survey tab and then on Log Raw GPS.
2. Tap on File Manager. The screen displays the following 

parameters:
• List of raw data filenames.
• Selected storage medium.
• Free memory available.
• Current number of raw data files in memory.

3. Unless already done, select Internal Mem to list the files 
stored in the internal memory.

4. To delete one file, highlight its name in the list and tap the 
Delete button. To delete all the files, tap Delete All Files.
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